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1 Introduction 
This short guide to the g-log series data logger and the related PC-software 

«LogView» will help you to get started with your g-log device. 

All basic steps to program the data logger, to read out and to analyze the recorded 

data are described. 

However, this document only covers the basic topics of LogView. For further 

information, please consult the online manual. 

 

Thank you for purchasing a g-log data logger.  
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2 Applications and Safety Regulations 

2.1 Operating Temperatures 
- The loggers can be used in the temperature range between -30° and +85°C.  
- Battery self-discharging increases above 45°C and continuous operation above 

45°C can reduce the serviceable life by approximately 1/3. 
- We cannot guarantee proper functioning below -40°C. Experience has shown 

that the batteries freeze at approx. -50°C and it is no longer possible to perform 
measurements. 

- A gas explosion can occur with the lithium batteries if temperatures exceeding 
100°C are reached. 

2.2 Precautionary Measures for Handling Units with Lithium 
Batteries 

- Do not short-circuit batteries: Danger of explosion. 
- Do not throw units which contain batteries into fire: Danger of explosion. 
- Do not subject the batteries to mechanical stress and do not dismantle them. 

The leaking battery fluid is highly corrosive and lithium can generate intense 
heat when it comes into contact with moisture or it can ignite. 

- Do not heat battery-powered units above 100°C: Danger of explosion. 
- Avoid subjecting the unit to violent knocks and blows. 
- Follow the manufacturer’s specifications for battery storage. 
- Return the batteries to the supplier for correct waste disposal. 
- Do not subject the batteries to microwaving: Danger of explosion. 

2.3 Serviceable Life 
Battery life-span is approximately 1.5 years for non USB devices and 2 years for 
USB-devices, depending on measurement interval and the number of recorded 
events and data readouts. 

2.4 Battery Level Display 
An energy consumption count monitors the life-span of the logger battery. For this 
reason, only the specific batteries recommended by the manufacturer should be used 
in the logger.  
You must reset the battery change time after you have replaced the batteries, 
otherwise the energy counter will not function properly! If you reset the battery 
change-time without replacing the batteries, the calculation of state of charge 
will give you invalid data. The state of charge will be displayed as too high. 

2.5 Technical Alterations 
In the interests of our customers, we reserve the right to perform alterations resulting 
from subsequent technical developments. For this reason, diagrams, descriptions 
and the information concerning the scope of delivery are subject to change. 
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3 Installing LogView 
To install LogView you must carry out the following steps: 
 
Attention:  When using an operating system featuring user-rights 

management, Log/View can only be installed using an account 
with administrator rights. 

 
1. Start Windows (if not already started). As a precaution, close any other 

applications. 
2. If you have a previous version of LogView installed on your system, make sure 

you uninstall it before proceeding with the new installation. 
3. Insert the LogView CD into a CD drive of your computer. The installation program 

will start automatically. 
If the installation program does not start automatically, use Windows Explorer to 
run the SETUP.EXE program from the LogView CD. 

4. Follow the instructions in the installation program. 
 
To start LogView, double-click the LogView icon on your desktop or use the start 
menu. 

Hints for operating systems with user administration 
When using an operating system featuring user-rights management the software can 
only be installed using an account with administrator rights. 

Hints for installing under Windows Vista 
1. The first time that LogView is run it requires administrator rights in order to install 

the licence key. This can be done by right clicking on the LogView.exe icon and 
choosing the Run as Administrator... menu option. 

2. The first time that a USB logger is connected to the system, the driver files will 
automatically be downloaded from the Windows Update website. This can take a 
couple of minutes. 

3.1 Minimum Requirements 
- Pentium Processor with Windows 2000, XP or Vista 
- CD-ROM Drive 
- 20 MByte Hard Drive Capacity 
- Serial Port (RS-232) or USB-Port  

3.2 Removing LogView 
To remove LogView from your system, run the automated uninstall program included 
with the product. Use the Add/Remove Programs icon located in the Control Panel. 
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4 Programming a new Mission 
LogView is designed for use with g-log data loggers. With integrated tools for 
programming your logger, advanced analysis and report capabilities LogView has 
everything you need for a complete analysis and documentation of your measure-
ments. Whether you want to display long data rows or events, graphical 
representations or a spreadsheet, with LogView you are able to analyze and present 
your collected data fast and easily. 

4.1 Connecting your data logger 
For programming data loggers and for upload of your measurements, a data logger 
needs to be connected to the computer. 

4.1.1 Connection 
Connect the data cable to a free COM- or USB-Port on your PC and connect the 
other end to the data logger. Make sure that no other program or device is already 
using this port. 
 

 
Figure 1: Connecting your data logger 

4.1.2 Communications Settings USB 
No communication settings have to be made, g-log USB data loggers will be 
recognized automatically by LogView 

4.1.3 Communications Settings RS-232 
For the old series of g-log data loggers with RS-232 interface, the COM-port has to 
be set. To change the communications settings: 
On the Options menu, click Communication Settings or, in the Com Port list box, 
specify the new communications port. Click OK to confirm your selection. If no Com 
Port is displayed, all Ports are in use or disabled.  
 

 
Figure 2: Communication Settings 

Note:  Before you start data transmission for the first time, you have to specify the 
desired communication port. Subsequent data transmissions will then be 
based on this setting. 
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4.2 Setting up new measurements 
Before you can start using your g-log data logger for measurements, you must 
program the device according to your requirements. 
LogView offers a convenient means of setting up the various features of your data 
logger. A series of measurements including the programmed settings is referred to 
below as the ‘Mission’. 

4.2.1 The Mission Wizard 
The LogView Mission Wizard guides you step by step through the process of device 
setup: 
To start the Mission Wizard: 
1. On the Mission menu, click Programming Wizard or click the New Mission Wizard 

button on the toolbar. The first screen of the Mission Wizard is displayed. 
2. Follow the instructions on the following wizard pages, using the Next and Back 

buttons to navigate.  

Welcome 

 
Figure 3: Mission Wizard - Welcome 

This page displays the currently connected device. 
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General Settings 

 
Figure 4: Mission Wizard - General Settings 

Use this page to enter all mission-related information, such as a brief description of 
the mission or the operator name. 
Note:  The maximum number of characters entered into the edit boxes is limited. The 

counters on the left side show you the number of characters left for each box. 

Start / Stop Mode 

 
Figure 5: Mission Wizard - Start and Stop Time 
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Table 1: Start/Stop Modes 

Mode Description 
Remote only The data logger can only be started/stopped using 

LogView. 
Manual The data logger can be started either with the manual 

buttons on the device or using LogView. 
Programmed Time The data logger starts/stops automatically at the 

specified date and time. 
Programmed or Manual The data logger can be started or stopped manually. If 

this is not the case, it starts/stops at the specified 
date/time. 

 

Shock Sensor Configuration (g-log sX, sthX) 

 
Figure 6: Mission Wizard - Sensor configuration 

The upper part of this window displays the sensors which should be activated during 
a mission (checked = activated). 
Note:  Disabled sensors will record no data. 
 
The lower part of this window displays which shock profiles are available. Existing 
profiles are listed and can be chosen by mouse-click. The selected profile is marked 
in blue.  

What is a profile? 
A shock profile defines the operating threshold of the acceleration sensors, which 
means the minimum acceleration and frequency at which to record an event. In 
addition, when using a Vibra logger device, there is an Event Interval entry. This 
specifies the length of a single Vibra logger event. 
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To set up a new shock profile or to change an existing profile: 
1. Click the New Profile button or the Edit Profile button. 
2. Enter your settings in the Edit Shock Profile dialog. 

 

 
Figure 7: Edit Shock Profile Dialog 

 
Table 2: Shock Profile Settings 

Parameter Description 
Profile 
Description 

Description of the current profile. Tip: use meaningful names! 

Trigger Level 
[g] 

Recording threshold. Events exceeding this level will be re-
corded. The unit for this parameter is g (acceleration due to 
gravity).2 
Note: 1g = 9.81 m/s2 

Corner 
Frequency 
[Hz] 
(Non-USB 
devices only) 

Value which defines the minimum frequency of an event to be 
record. Vibrations with a frequency below this value will not be 
recorded. Use this setting to suppress undesired vibrations in 
your measurements.  
(Technical detail: Adjustable 2nd order high pass-filter.) Use 
this setting to suppress undesired vibrations in your 
measurements. 

Time Interval 
[ms] 

(Read only) Sampling rate during acquisition of a shock event 

Event Interval 
(Vibra logger 
only) 

A continuous Vibra logger measurement is split into events of 
this length. The default value is 10 seconds. 

                                            
2 The acceleration will be recorded until the maximum log time for an event is reached or the 
amplitude of acceleration falls below the value in "Trigger Level". 
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Time Series Settings (g-log sthX) 

 
Figure 8: Mission Wizard – Summary 

 
Use this dialog to enable/disable and to configure the time series sensors connected 
to your g-log data logger. 
 
Note:  Time Series measurements can be disabled by unchecking the 

box Enable T/rH Sensor. Disabled sensors will record no data. 

Settings 
You can either use the slider to select the sampling rate (time interval) from 
predefined values or enter a custom value if you check the Custom check box. 
 
Estimated Log Time indicates the possible log time for the current sample rate. 
 

Caution! 

Specifying short time intervals (< 5 minutes) will decrease battery lifetime. Check 
battery level regularly. 
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Alarm Settings (not for Vibra logger) 

 
Figure 9: Mission Wizard - Alarm Settings 

 
The g-log data loggers provide alarm capabilities for every connected sensor. An 
event which exceeds the user-defined limits will be indicated on the device (flashing 
red LED) and documented in the mission report. 
 
To enable alarms: 
In the Alarm Settings Dialog, mark the On/Off checkbox to enable the alarm function. 
In the Upper Limit and Lower Limit edit fields, enter the alarm thresholds. There is an 
additional Time Span field for shock sensors. This value specifies the time during a 
shock event that the upper limit must be exceeded before an alarm event is 
recorded. If an alarm event should be recorded immediately when the alarm level is 
exceeded, then the value 0 can be entered here. More information about this setting 
can be found in Chapter 11 (About Shock Measurement). 
 
Important note 
The Upper alarm limit for shock sensor is the maximum acceleration value on all 
three axes (not a Norm value!). 
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Summary 

 
Figure 10: Mission Wizard - Summary 

This page shows a summary of the new data logger configuration. 
 
If the settings match your requirements: 
Click Finish to apply the settings to the device. 
To change some of the settings, click Back to return to the previous screens. 
To discard all changes, click Cancel. 

4.3 Multi Programming 
Log/View supports programming more than one logger with identical settings. 
After a g-log is successfully programmed, the following dialog box appears: 
 

 
Figure 11: Multi Programming 

 
If you want to program another logger with the same settings, click Yes. LogView will 
ask for the next g-log to be connected and the Mission Wizard starts anew, where the 
last settings remain.  
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5 Analyzing a Mission 

5.1 Data transmission 
To analyze and document the measurements, the recorded data need to be trans-
mitted from the data logger to the computer. 
 
Transmission of recorded data: 
 
1. Connect the data logger to a free serial port on your computer, using the data 

cable supplied with LogView. 
2. Click on the Transmit button on the Toolbar (or, on the Mission menu, click 

Transmit). The data will be transmitted and displayed in the Mission Explorer on 
the left hand side of the LogView screen. 

5.2 Navigating in LogView 
LogView organizes measurements in so-called missions. A mission contains all 
relevant information such as the name, times of start and stop as well as all the other 
events and measurement values. To navigate in these missions, LogView provides 
the Mission Explorer: 

Mission Explorer 

 
Figure 12: Mission Explorer 
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The Mission Explorer consists of two views: 

Mission Tree View (Figure 12, left hand side) 
All open missions and the connected device are displayed in the Mission Explorer 
Tree View. Click on a tree item to open the corresponding window. 

Mission List View (Figure 12, right hand side) 
The Mission List View is an additional navigation window. The content of the window 
corresponds with the current selection in the Mission Tree View. 

Mission Explorer Icons 

Table 3: Mission Explorer Icons 

 

Current online mission 
(connected with logger, not yet 
stored) 

 

Table view of the recorded sensor 
data 

 
Mission stored on disk 

 
Table view of the recorded sensor 
alarm data  

 

Measurements (folder which 
contains the measurement 
data) 

 

Mission events, a list of events which 
occurred during a mission (e.g. start, 
stop, readout, ...) 

 

Shock measurements 
containing all recorded shock 
data 

 

Mission report, a summary report of 
the mission events and data 

 

Temperature and humidity 
measurements containing all 
temperature/humidity data  

 

Device report, a summary of the 
currently connected device  

 
Graph view of the recorded 
sensor data  

Currently connected device 
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5.3 Data analysis 
Depending on the sensors connected to your g-log data logger, LogView provides 
different ways of analyzing the recorded data. 
 
To analyze measurement data: 
 
1. In the Mission Explorer, expand the Measurements node by clicking on the plus 

sign on the left of the icon or double-clicking the icon. 
2. Select from either graphical or tabular view of your data by clicking on the 

corresponding icon. 

5.3.1 Graph View shock (g-log sX, sthX) 
The Graph View is split in two screens. The upper screen displays the summary of 
the mission. The lower screen shows the details of a selected event. 
 

 
Figure 13: Graph View - Shock 
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Summary View (upper part of Window) 
The Summary View shows all recorded events between mission start and mission 
stop. If the mission has not yet ended, it shows all the recorded events to date. 
 
Note: Overlapping events 
Especially on long missions, it may happen that different shock events displayed in 
the Summary View appear as one single event. These overlapping events are drawn 
with a label above the bar, specifying the number of overlapping shock events. To 
show/hide these labels, select Label Events on the Graph menu. 
 
Important: The amplitude of an event displayed in the Summary View is the 

maximum absolute acceleration value on all three axes (not Norm 
values!) 

 
Table 4: Events in the Summary View 

Shock events Vertical line. 
The height of the lines corresponds to the intensity of 
the events (max. acceleration). 

System events (e.g. 
start/stop of mission) 

Diamond 

 

To select an event  
1. Make sure that the summary view is active (Border line around the graph). If the 

graph is not active, left click in the graph to activate the view. 
2. If necessary, zoom in to the area of interest. 

Note: A zoomed graph is marked with a lens symbol in the upper right corner. 
3. Select an event by a left click. 
4. The event details are displayed in the lower screen (Details View). 

Details View (lower part of Window) 
The Details View shows the details of the event selected in the Summary View. You 
can choose from two display options: 
 
Table 5: Details View Display Options 

Axes 
Displays all three axes 

To see all three axes, click on Axes Tab below the 
Details screen. 

Total Acc. (Norm)  
Displays the total 
acceleration 

To analyze your data by the norm value of the 
acceleration vector click on the Total Acc. (Norm) Tab 
below the Details screen. 
Note: 
The norm value of the acceleration is defined by:  

Norm = 222 zyx   

Spectrum Analysis 
(LogView Professional 
only) 

To analyze the frequency spectrum of your data click 
on the Spectrum Analysis Tab below the Details 
screen. This is split into separate tabs for the X, Y and 
Z axes. 
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5.3.2 Graph View temperature/humidity (g-log sthX) 
The T/rH Graph View displays recorded temperature, humidity and dew point data. 

Note:  The dew point is the temperature at which the air can just hold on to the 
contained water vapour. If the temperature drops below the dew point, 
moisture condenses. 

 

 
Figure 14: Graph View – T/rH 

Show/Hide Data 
LogView offers the possibility of hiding lines of the temperature/humidity chart.  
 
To show/hide a specific line: 
1. Right click in the graph and select Show/Hide Lines from the context menu.  
2. Select/deselect the line to show/hide. 
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5.3.3 Additional Graph Functions 

Grid Lines 
Every Graph displayed in LogView can display grid lines. 
 
To show/hide the grid lines 
Right click in the graph to show/hide the grid lines and select/deselect Grid Lines 
from the context menu 
or 
on the Graph menu, select/deselect Grid Lines. 

Zoom functions 
Every Graph View can be zoomed. 
 
To zoom in on a Graph: 
Select the area of interest by holding the left mouse button pressed while dragging 
the zoom rectangle. After releasing the mouse button, the chosen area is zoomed in. 
 
To zoom back a Graph (previous zoom): 
Right click in the zoomed graph and select Zoom Back from the context menu. 
or 
on the Graph menu, select Zoom Back 
or 
press B on the keyboard. 
 
To zoom out of a Graph: 
Right click in the zoomed graph and select Reset Zoom from the context menu. 
or 
on the Graph menu, select Reset Zoom 
or 
press R on the keyboard. 
 

5.3.4 Customize a graph 
Right click in the graph and select Customize to change line color, style and width. 

Display Range of Y-Axis 
The display range of the Y-axis can be set manually or automatically in the Axis 
Settings tab: 
On the Graph menu select Auto 
or 
deactivate Auto and enter the values for minimum and maximum. 
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Figure 15: Set Display Range of Y-Axis 

Line Style 
The colour, width and style of each line can be adjusted individually in the Graph 
Style tab. 
 

 
Figure 16: Adjusting Line Style 

 

5.3.5 Filter Functions (LogView Professional Only) 
To enable or disable the filter: 
Right click in the graph and select Filter Data from the context menu 
Or 
on the Graph menu, select Filter Data 
Or 
press F on the keyboard. 
 
Note: The filter type and parameters can be set using the Options / Filter Settings 
item in the main menu. 
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5.3.6 Tabular View Shock (g-log sX, sthX) 
The Tabular View is split in two screens. The upper screen displays the summary of 
the mission. The lower screen shows the details of a selected event. 
 

 
Figure 17: Table View - Shock 

Summary View (upper screen) 
The Summary View shows all recorded shock events between mission start and 
mission stop. If the mission has not yet ended, it shows all the recorded events to 
date. The columns Alarm Limit X, Y and Z show the time, for which the given axis 
has a shock value greater than the alarm limit. If this time is greater than the value 
given for Alarm Time Span then this event is recorded as an alarm event. 
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To select an event: 
1. Left-click on the desired event in the Summary View. 
2. The event details are displayed in the lower screen (Details View). 
 
Sorting: 
By clicking on the table header of the summary view (Event Number, Date/Time, 
Total Acc.) the table may be sorted according to the selected header (ascending or 
descending). 

Details View 
The Details View shows the numerical data of an event according to the Graph View. 

5.3.7 Tabular View temperature/humidity (g-log sthX) 
The Tabular View displays the detailed data of the mission (Temperature, humidity 
and dew point). 
 
Note: If the tabular view displays a N.C. instead of the values, the sensor was not 
connected or the acquisition has been interrupted by shock events. 
 

 
Figure 18: Table View - T/rH 

5.3.8 Tabular View alarms shock / temperature/humidity (g-log sthX only) 

The Alarm Tabular View displays the detailed alarm data of the mission (Shock, 
Temperature, humidity and dew point). 
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5.3.9 Data export 
LogView provides data export either in Microsoft Excel, HTML or in Tab-delimited file 
format. Only table view allows data export  
 
To export data from LogView: 
1. Ensure that the table containing the data you want to export is activated.  

(A mouse click in the window activates the window.) 
2. On the Table menu, select Export and choose the required export format 

or 
right click in the table and select Export. 

3. Choose the required file format. For an export directly into Excel (without saving 
data in a file) choose the function Excel / Open… 

4. Follow the instructions on the screen. 
 
Note:  Exporting large Data columns in Excel or HTML format may take several 

minutes. Alternatively, data can be exported in tab-delimited file format, 
which proceeds much faster. Afterwards, this file can be imported to Excel. 

5.3.10 Bulk Export 
LogView's Table View provides a means to export all the events portrayed in a single 
bulk export action. The data can be exported as Excel Spreadsheets, HTML tables or 
tab-delimited text files.  
A menu of bulk export options is available on the Table menu. Click Bulk Export to 
access this menu and select the file format required for export:  
 

 
Figure 19: Bulk Export 

Alternatively, a menu of bulk export options is available on the context menu 
associated with the table. Right-click on the table to see this menu, or ensure that the 
table has the focus by clicking on it and then press the Windows Context Menu key. 



 

© solve gmbh The contents of this document is subject to change without notice 
 

Formats 
Supported formats are Microsoft Excel Spreadsheet, HTML Tables and Tab-
delimited Text. 
Bulk Export to Excel spreadsheets is directed to a set of separate files. Merged 
export to a single file is only supported in Excel / Open... One file is generated 
containing a table of events, corresponding to the events list in the Table View. 
(Uppermost grid.) The remaining files contain the data of the individual events.  
 

5.4 Analyzing Mission Events 
All g-log data loggers record events occurring during a mission, e.g. programming, 
on/off etc. The mission event list contains a list of all events which occurred during 
this mission. The following events are recorded and displayed in the event list: 
 
Table 6: Mission Events 

Event Description 
Started at programmed 
time 

The logger started recording at the programmed time 

Stopped at 
programmed time 

The logger stopped recording at the programmed time 

Started manually The logger was started manually using the start button at 
the given time 

Stopped manually The logger was stopped manually using the stop button at 
the given time 

Started by remote The logger was started remotely by LogView 
Stopped by remote The logger was stopped remotely by LogView 
Unallowed try to start 
logger, Button disabled 

It was attempted to start the logger manually, but the start 
button was disabled for this mission. 

Unallowed try to stop 
logger, Button disabled 

It was attempted to stop the logger manually, but the stop 
button was disabled for this mission. 

Power fail A power failure occurred, possibly caused by a battery 
change or empty batteries 

Read out of recorded 
events 

Mission was read out at the given time 

Programmed new 
mission 

A new mission was programmed at the given time 

Unknown event An unknown Event has been recorded. Most possibly 
caused by an old LogView version reading out the logger 
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Table 7: Additional Mission Events for Vibra Logger 

Event Description 
Measurement started by trigger The measurement was started automatically after 

the logger detected a shock greater than the trigger 
level. 

Measurement started manually The measurement was started manually using the 
start button. 

Measurement stopped manually The measurement was stopped manually using the 
stop button. 

Measurement stopped, memory 
full 

The measurement was stopped because the logger 
memory was full. 

Unallowed try to start 
measurement, memory full 

It was attempted to start the measurement 
manually, but the logger memory was full. 

Unallowed try to start 
measurement, button disabled 

It was attempted to start the measurement 
manually, but the start button was disabled for this 
mission. 

Unallowed try to stop 
measurement, button disabled 

It was attempted to stop the measurement 
manually, but the stop button was disabled for this 
mission. 

Measurement stopped by 
communication 

The measurement was stopped because it was 
connected to a PC and data was read from the 
logger. 

 
 
Example: 

 
Figure 20: Mission Events (Example) 
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5.5 Data Filters (LogView Professional Version Only) 
The shock data can be filtered before it is displayed using a number of different 
signal filters.  
 
To configure the filter parameters: 
1. On the Options menu, click Filter Settings. 
2. Enter the filter settings in the dialog. 
 

 
Figure 21: Filter Settings 

 
The following parameters can be set: 
 
Filter Enabled Enables or disables the filter in all shock graph views. 
Filter Type The type of the filter: 

 Lowpass 
 Highpass 
 Bandpass 

Filter Parameters The filter parameters: 
 Filter order 
 Cutoff Frequencies 

Table 8: Filter Settings 

Example 
The following are example values which can be used for a lowpass filter: 
 
Weak filter  : Order = 1, Lower Cutoff Frequency  = 10Hz 
Strong filter : Order = 5, Lower Cutoff Frequency = 10Hz 
 
Hint 
The filter can also be enabled or disabled using the chart context menu (see section 
5.4.3). 
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6 Reporting functions 
LogView is able automatically to generate the reports needed for documentation of 
your measurements. After the mission data is transferred to LogView, the program 
will automatically generate a mission report and a device report. 
Also, all graph- and table views can be printed out for documentation purposes. 

6.1 Printing 
To print out a report: 
Make sure you have selected the report, graph or table you want to print in the 
Mission Explorer. (In the shock graph or table view, also select the view you want to 
print.) 
1. Click on the printer symbol in the toolbar list or on the File menu, click Print  

(to preview the printout, click Print Preview). 
2. The report will be printed to the selected printer. 

6.2 Mission Report 

6.2.1 Report content 
The mission report gives a summary of the current mission. This contains information 
about the mission, the logger and the configuration as well as a list of the recorded 
impacts and the minima and maxima of the climate values. 

User comment 
An additional user comment can be inserted for further documentation purposes. 
To insert a user comment: 
Make sure you have selected the Mission Report window in the Tree View. 
1. On the Mission menu, click User Comment  
2. Enter comment 
3. User comment will be displayed at the bottom of the mission report.  
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Example 

 

 
Figure 22: Mission Report (Example) 
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6.3 Device Report 
The device report displays information about the device currently connected to 
LogView. To retrieve the current device information, select Update Device Info on the 
Device menu. 

6.3.1 Report content 
The report contains information such as battery level, serial number, date of last 
calibration, etc. 

Example 

 
Figure 23: Device Report (Example) 

6.4 Sensor reports 
The current sensor settings can be viewed by selecting the corresponding sensor 
element in the mission explorer. 

Shock sensor 

 
Figure 24: Sensor Configuration - Shock 
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T/rH sensor 

 
Figure 25: Sensor configuration - T/rH 
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7 Working with your data logger 

7.1 Configuration 
To configure data logger settings like password or time settings: 
1. On the Device menu, click Settings. 
2. Enter the data logger settings in the different dialog pages. 

7.1.1 Logger Time 
Use this dialog to change the time settings on the data logger. 
 
Caution: Please ensure you enter the correct time. Wrong time settings will result 

in measurements containing incorrect time stamps. 
 

 
Figure 26: Logger Settings – Logger Time 

 
To read out the current logger time, click Get. 
To enter a new logger time, enter the date and time and click Set or click Set to PC 
time to set the time to the PC-time. 
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7.1.2 Password 
To protect the data logger against tampering attempts, password protection can be 
enabled. 
If you forget this password, you must contact your g-log data logger partner to 
unlock your device. 
 

 
Figure 27: Logger Settings - Password 

Password protection logic 

Overview 
Each data logger provides password protection against unauthorized manipulation. 
Data of a password-protected device can be read out. However, it is not possible to 
start/stop a logger, to set up a new mission configuration or to change data logger 
settings without entering the correct password first. 
 
Note: The password is stored in the data logger, so you have to remember the 

password for every device. 

Password protected areas 

Table 9: Password protection logic 

 Password protection 
enabled 

Yes No 
Data transmission  X 
Data analysis and 
report generation 

 X 

New mission setup X  
Changing logger 
settings 

X  

Remote Start/Stop X  
Reset Alarm X  
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7.1.3 Battery 
This Dialog shows the state of charge and the date of the last battery change. If you 
change the battery, you should press the button to set the new values. 
 
Caution:  If you reset the battery change-time without replacing the batteries, 

the calculation of state of charge will give you invalid data. The 
state of charge will be displayed as too high! 

To set the battery change time: 
1. Click Set Battery Change Time on the battery dialog. 
2. The Battery change date will be set immediately to the actual date and the Battery 

Level will change to 100%. 
 

 
Figure 28: Logger Settings - Battery 
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7.2 Operating the data logger via LogView 
The following data logger functionalities can be accessed via LogView: 

7.2.1 Remote Start / Stop of the device 
To start/stop the connected data logger remotely: 
On the Device menu, select Start or Stop 
or 
use the toolbar buttons. 
 
Note: The device report containing the information about the logger state is not 

updated until you select Update Device Info from the Device menu or the 
complete data is transmitted anew (Transfer). 

7.2.2 Alarm Reset 
To reset the alarm indicator on the data logger 
On the Device menu, select Reset Alarm. 

7.2.3 Device Info Update 
To update the device information displayed in the Device Report: 
On the Device menu, select Update Device Info.  

7.3 Manual operation  
The most important operating states of the g-log data logger are shown by two LEDs. 
Also, the data logger can be turned on and off by using the start and stop buttons. 
For security reasons the start and stop buttons can be deactivated by the software. 
See also chapter 4.2 Setting up new Measurements – Start / Stop Mode. 

7.3.1 Set-up of Control Buttons 
The control and display elements of the g-log standard series are internal. The g-log 
E-series has additional control elements on the cover which allows one to start and 
stop the device without opening the device. 

7.3.2 Buttons and Indicators s1/sth1 
The data loggers have a green and a red indicator lamp which show the actual 
device state and the alarm state. 
 

 
Figure 29: Buttons and indicators s1/sth1 
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7.3.3 Buttons and Indicators s1-E/sth1-E 
The E-series data loggers have a green and a red indicator lamp integrated within 
the housing. The button next to the green indicator lamp is equivalent to the ON-
button; the button next to the red indicator lamp is equivalent to the OFF-button, 
 

 
Figure 30: Buttons and indicators s1/sth1 

Tip: Protected against tampering 
The design of the controls and indicators allows one to cover the buttons with a tag 
or just simply hide them behind a label. This way you can ensure very easily that only 
insiders are able to recognize the controls and indicators in order to switch the device 
on or off. 

7.3.4 Operating and Indicators 

Device State indication 
If the data logger is active, the green lamp will flash every third second.  
 
Data recording indication 
A shock event recording is indicated if the green indicator flashes for a short time. 
 

Alarm 
If alarm levels have been exceeded, the red lamp will flash synchronously to the red 
lamp. 

Start / activating the data logger 

1. Press and hold on the on button for more than 1 second. 
The green lamp will flash to indicate activation. 

2. Release the button. 

Stop / deactivating the data logger 
1. Press and hold on the off button for more than 1 second. 

The red lamp will flash to indicate deactivation. 
2. Release the button. 
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7.4 General Settings 
General settings, which are used throughout the application, must be set in the menu 
General Settings. 
Click General Settings on the Options menu. 
 

 
Figure 31: General settings 

 

7.4.1 Temperature Unit 
Use the Centigrade/Fahrenheit control elements to change the temperature unit used 
in LogView. 

7.4.2 Transmit Mode 
In this version of LogView, no dynamic upload is supported. All recorded data is 
transmitted at the time the user selects the Transmit function. 

7.4.3 Alarm Filter 
Enabling the alarm time filter will reduce the amount of events displayed when using 
a logger which has an alarm time span parameter set. Shock events which exceed 
the alarm upper limit for less than the given time span will not be displayed. 
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8 Using the g-log data logger 
The g-log data loggers are tri-axial shock recorders. The coordinate system of the 
built-in acceleration sensor is displayed on the device. 
 

 
Figure 32: Coordinate system 

8.1 Mounting 
The g-log data loggers are designed for use under difficult conditions. The measure-
ment electronics is protected by a solid and hose-proof aluminum case (IP 65). 

Mounting Guidelines Shock (g-log sX, sthX) 
The data logger must be rigidly connected to the goods that are to be supervised. 
Normally the device will be screwed to the goods using M5 screws. 
Attach the data logger tightly to the goods and avoid any cushioning materials in bet-
ween. Otherwise, measurements could be compromised. Inadequate or loose 
mounting can also compromise measurements, caused by vibrations between the 
goods and the data logger. 
 

Mounting Guidelines Hygroclip (g-log sthX) 
Ensure there is adequate air circulation to ensure the sensor reports the true climate 
of the goods to be monitored.  
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9 Dimensions 
See drawings below (all dimensions in mm). 

 
Figure 33: Dimensions g-log 

 
 

 
Figure 34: Dimensions Hygroclip 
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10 Maintenance 
Like every measurement device, the g-log data loggers need maintenance. The g-log 
data logger complies with the EN 15433-6 standard documents. To comply with the 
EN directives, a recalibration of the device every two years must be conducted. 
Please contact ‘solve gmbh’, Switzerland or your local agent for further information. 

10.1 Calibration 

Calibration Service 
The calibration service includes battery replacement, inspection, adjustment and 
certification of the data logger. 

Check-up 
A check-up includes an electrical check-up of the device and a battery replacement. 
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11 About shock measurement 

11.1 Shock basics 
 

 
Figure 35: Stress factors 

 
Table 10: Stress factors 

Climatic stress Temperature, Humidity, Wind, etc. 
Static stress Mechanical, e.g. stack pressure. 
Dynamic stress Mechanical, e.g. impacts, vibrations. 

 
The g-log shock recorders acquire acceleration and, optionally, climatic conditions. 
Therefore, they are able to record dynamic stress acting on objects. 

11.1.1 Dynamic stress 
Dynamic stress can be divided in the following categories: 
 
Table 11: Dynamic Stress 

Category Definition Examples 
Impacts Mechanical-dynamic stress, 

arising out of mass 
acceleration. Occurring 
sporadically and in varying 
intensity during transportation. 

Horizontal or vertical impacts 
(Dropping, toppling, crashing into 
other objects). 

Vibrations Periodically-occurring stress 
resulting from vehicle 
movement. The vibrations are 
transferred to the object in 
form of horizontal and vertical 
impacts. 

Horizontal and vertical impacts 
(Engine vibrations, scrubbing, 
friction, badly conditioned 
transportation route). 
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Impacts 
An impact is identified by its amplitude (max. acceleration value) and its duration. 
During an impact the acceleration increases, reaches a maximum value and 
decreases again. 
 

 
Figure 36: Impact modes 

Elastic impact 
The shorter the duration of the impact with a given velocity, the higher is the 
acceleration. In an elastic impact, the object maintains its kinetic energy. 

Inelastic impact 
At the end of the impact, the velocity of the object is zero. The entire kinetic energy of 
the object is transformed into deformation and heat. 
 
In practice, impacts are a mixture between elastic and inelastic impacts.  
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11.1.2 Typical stress values* 

Road transport Impacts (app.): 1g 
Natural frequency (app.): 10..15Hz 

Rail transport Impacts (app.): 4g (shunting) 
Natural frequency (app.): 120Hz 

Sea transport Impacts (app.): 2g 
Natural frequency (app.): 30Hz 

 
* The above values are reference values only and heavily dependent on competent 
handling and the condition of the transportation route. 
 

11.1.3 Damage Boundary Curve (DBC) 

 
What decides whether an object is damaged by an impact is not the amplitude, nor 
the maximum shock. Instead it is the length of time for which the shock is greater 
than a given value. The boundary of the curve in a shock-time diagram, which shows 
the values which must be exceeded for an object to be damaged is called a Damage 
Boundary Curve. 
 

 
 
So that the logger can only record alarm events when the impact meets these 
conditions, the alarm configuration contains parameters for both the alarm threshold 
and the minimum time span. 
 

     

No damage

Damage

Time

                Shock 

Minimum Timespan 

Alarm 
Threshold 
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12 About Temperature / Humidity Measurements 
 
Dew Point and Relative Humidity explained 
 
Relative Humidity and Dew Point are closely related, and are based upon the amount 
of water vapor in the air and the total amount of water vapor that the air can hold at a 
given temperature. The warmer the air, the more water vapor it can contain, and the 
cooler the air, the less vapor it can contain. This is the reason moisture will condense 
on a cold glass or other cold object: as the air near the object cools, it reaches the 
point where cannot contain all the water which it held at a warmer temperature, and 
some moisture "falls out" of the air. 
The Relative Humidity expresses how much moisture is in the air, as a percentage of 
the total moisture the air can contain at the current temperature. For example, if the 
air has all the water vapor that it can contain at a given temperature, the relative 
humidity is 100%; if the air has only half of the vapor that it can contain at a given 
temperature, the relative humidity is 50%.  
 
The dew point is the temperature where the air can contain exactly the amount of 
vapor the air currently holds. If the temperature falls below the dew point, moisture 
will condense. 



 

  p 45/45 

13 Appendix 

13.1 Tables 
Table 1: Start/Stop Modes ..................................................................................................................... 10 
Table 2: Shock Profile Settings ............................................................................................................. 11 
Table 3: Mission Explorer Icons ............................................................................................................ 16 
Table 4: Events in the Summary View .................................................................................................. 18 
Table 5: Details View Display Options .................................................................................................. 18 
Table 6: Mission Events ........................................................................................................................ 25 
Table 7: Additional Mission Events for Vibra Logger ............................................................................ 26 
Table 8: Filter Settings ........................................................................................................................... 27 
Table 9: Password protection logic ....................................................................................................... 33 
Table 10: Stress factors ......................................................................................................................... 41 
Table 11: Dynamic Stress ..................................................................................................................... 41 

13.2 Figures 
Figure 1: Connecting your data logger .................................................................................................... 7 
Figure 2: Communication Settings .......................................................................................................... 7 
Figure 3: Mission Wizard - Welcome ....................................................................................................... 8 
Figure 4: Mission Wizard - General Settings ........................................................................................... 9 
Figure 5: Mission Wizard - Start and Stop Time...................................................................................... 9 
Figure 6: Mission Wizard - Sensor configuration .................................................................................. 10 
Figure 7: Edit Shock Profile Dialog ........................................................................................................ 11 
Figure 8: Mission Wizard - Summary .................................................................................................... 12 
Figure 9: Mission Wizard - Alarm Settings ............................................................................................ 13 
Figure 10: Mission Wizard - Summary .................................................................................................. 14 
Figure 11: Multi Programming ............................................................................................................... 14 
Figure 12: Mission Explorer ................................................................................................................... 15 
Figure 13: Graph View - Shock ............................................................................................................. 17 
Figure 14: Graph View – T/rH ............................................................................................................... 19 
Figure 15: Set Display Range of Y-Axis ................................................................................................ 21 
Figure 16: Adjusting Line Style .............................................................................................................. 21 
Figure 17: Table View - Shock .............................................................................................................. 22 
Figure 18: Table View - T/rH ................................................................................................................. 23 
Figure 19: Bulk Export ........................................................................................................................... 24 
Figure 20: Mission Events (Example) .................................................................................................... 26 
Figure 21: Filter Settings ....................................................................................................................... 27 
Figure 22: Mission Report (Example) .................................................................................................... 29 
Figure 23: Device Report (Example) ..................................................................................................... 30 
Figure 24: Sensor Configuration - Shock .............................................................................................. 30 
Figure 25: Sensor configuration - T/rH .................................................................................................. 31 
Figure 26: Logger Settings – Logger Time ............................................................................................ 32 
Figure 27: Logger Settings - Password ................................................................................................. 33 
Figure 28: Logger Settings - Battery ..................................................................................................... 34 
Figure 29: Buttons and indicators s1/sth1 ............................................................................................. 35 
Figure 30: Buttons and indicators s1/sth1 ............................................................................................. 36 
Figure 31: General settings ................................................................................................................... 37 
Figure 32: Coordinate system ............................................................................................................... 38 
Figure 33: Dimensions g-log.................................................................................................................. 39 
Figure 34: Dimensions Hygroclip .......................................................................................................... 39 
Figure 35: Stress factors ....................................................................................................................... 41 
Figure 36: Impact modes ....................................................................................................................... 42 
 


